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INTRODUCTION 
 
 
The Crowcon Hydra Addressable Gas Detection System is designed to monitor toxic and/or 
flammable gas hazards. The system must be installed and operated in accordance with 
these instructions. No components of this system are certified for use in a hazardous area. 
 
 
 
 

WARNING 
 
 

The equipment described in this instruction manual has mains 
voltages applied to it.  Ensure correct safety procedures are adopted 
before working on the equipment. 
 
The equipment described in this manual is designed for detection of 
flammable and/or toxic gases. Ensure local safety procedures are 
adopted before carrying out any maintenance or calibration work. 
 
The equipment described in this manual may be connected to remote 
alarms and/or shutdown systems.  Ensure that local operating 
procedures are adopted before carrying out any maintenance or 
calibration work. 
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1. INTRODUCTION 
1.1 CONTROL PANEL DESCRIPTION 
The Crowcon Hydra gas detection control system has been designed to enable simple 
installation and expandability with minimum cost and installation times. Detectors are 
connected to the control panel via one to four RS-485 addressable loops, with up to 30 
detectors on each. The control panel is thus able to control up to 120 gas detectors. 

The control panel is also able to control up to 128 remote outputs (open-collector type), all 
of which are programmable. These outputs, combined with the four built-in relays can be 
used to indicate the system status remotely or provide control of auxiliary equipment. 

An RS232C serial port is provided for connection to a Personal Computer, which permits 
programming of the control panel in minimum time. The system can be connected to a site 
management system via the same serial port which, when using appropriate software, can 
create graphic maps and permit the remote control of the system. 

Real time printouts of alarms (or event log information) can be obtained from a printer 
connected to the Centronics parallel port. 

1.2 SYSTEM CONFIGURATION 
 
 

 
 
Figure 1 – System Block Diagram 
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1.3 TECHNICAL SPECIFICATION 
 
Addressable Control Panel Specification 

 
Size: 430mm x 410mm x 140mm (width x height x depth) wall 

mounted version. 19” 3U rack version available. 
Inputs: Maximum number of detectors: 120 arranged on 4 

addressable RS-485 loops (30 detectors maximum per loop) 
1 Km maximum cable length* 

Outputs: 4 output relays rated 220Vac 10A 
Optional 16-way output modules (maximum of 8 can be 
connected). Each module has 16 open-collector outputs 
each capable of sinking 50mA. 
RS-232 Modbus interface for data transfer to 
BMS/DCS/SCADA systems  
RS-232 port for local system configuration and log upload 
Parallel printer port (Centronics) for automatic event printing 
Event log function capable of storing up to 800 events 

Panel Indication: Back-lit LCD display. 256 x 64 pixels 
 Red LED’s for Alarm 1, Alarm 2, Alarm 3  
 Yellow LED for Fault 
 Panel sounder can be de-activated 
 Green LED for Power Status (plus mains fail indication) 
 Soft-keys for system configuration 
Power:     230V ac 50-60Hz 5.5W (110Vac optional) or 12Vdc 
     Battery back-up is available as an option 
Operating Temperature: 0 to +40º C (storage temperature -15 to +55ºC) 
Humidity: 15-85% non-condensing  
 
Detector Specification 

 
Construction:    Alloy 
Size:     96mm (w) x 152mm (h) x 60mm (d) 
Certification: Not hazardous area certified; safe area use only 

Operating Temperature:   -10 to +55o C 
Humidity:    20-90% RH non-condensing (@40°C) 
Ingress Protection:   IP55 
Voltage:    12-27V DC, 90mA max. (CO/NO2 version 40mA) 
Outputs: RS-485 addressable communications 
Calibration: Requires hand-held keypad 
Gases and Ranges: 0-300ppm CO (electrochemical sensor) 
 0-25ppm NO2 (electrochemical sensor) 
 0-100% LEL LPG/Propane (catalytic bead) 
Sensor Life: 3-years typical 
T90 Response Time: <60 secs* 
Accuracy: 5% of range or 10% of display* 
Accessories: Hand-held calibration keypad 
 Weather protection cone 
 Calibration adaptor 
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*Specifications are typical and may vary dependant on site conditions 
2. INSTALLATION 
2.1 CONTROL PANEL 
 

Note: The following instructions refer to the wall-mounting version of the Crowcon 
Hydra product. The 19” Rack mount version of the product will be supplied as 
separate modules, and an additional 12Vdc PSU will be required. 

Mount the control unit using the four mounting holes as shown in Fig. 2. 

Connect the three core mains supply cable to the power supply terminals (1.5 mm2 per core 
minimum) and secure it with the appropriate cable grip. 

Connect the detector loop cables to the Communication Cards following the diagrams 
shown in Fig. 3, before powering up the control panel. 

After powering up the control panel connect the red and black battery cables (fitted with 
6mm blade connectors) to the standby lead acid battery (12Vdc / 15 Ah max.). The battery 
should be carefully fitted into the space next to the power supply (battery compartment) 

Due to the vast range of batteries available, it has not been possible to create a universal 
fixing system. It is therefore recommended that either double sided adhesive tape or tie 
wraps with an adhesive base be used to anchor the battery. 

 
 

FIELD INTERFACE CARD

COMMUNICATION CARD

MOUNTING HOLES

POWER SUPPLY
VAC
VAC

CABLE GRIP
BATTERY

FRONT PANEL

MOUNTING HOLES

380 mm +/- 0.1

430 mm +/- 0.1

360 m
m

 +/- 0.1

410 m
m

 +/- 0.1

 
Figure 2 – Control Panel Mounting Arrangement 
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2.2 DETECTOR CONNECTIONS 
Communication between the control panel and the detectors is achieved via an RS485 bus. 
The control panel constantly monitors the detector loops connected to it. A break in 
communication from any detector generates a fault alarm. 

The cable used to connect the detectors and/or remote output modules must be screened 
and twisted 2-core cable for RS485 serial connection (the cable screen must be connected 
only to the earth of the control panel). The 24V & 0V supply to the detector must be carried 
either using two extra cores, or using a separate cable. Junction boxes local to each 
detector are recommended for ‘marshalling’ power and signal cables. 

Crimp-type connectors should be used to ensure cables do not oxidise or loosen. 

2.2.1 Detector Signal Cables 
Wiring between the detectors and the control panel Serial Boards should be made by using 
connection cable EIA RS485: 2 core wires with section 0.22 / 0.35 mm2 and shield (twisted 
pair). Nominal capacity between the wires < 50pF/m, nominal impedance 120 ohm.  

These features can be found in BELDEN 9542 cable or similar (data transmission cable in 
EIA RS485). Using this cable, the detector line total length should not exceed 1000 m.  

Detectors and output modules are to be wired in daisy chain mode. We recommend 
avoiding star or tree mode connection as interference immunity would be reduced. 
 
Should any cable junctions be necessary please make sure there is no interruption in the 
cable shield (screen). Please remember that the shield should be connected to the ground 
at the control panel end only; never connect the shield to the detectors. 
 
Ensure that each 2-core detector bus cable wire includes just one RS485 (ie is not 
connected to another RS485 network). 

Also ensure that a 120 Ohm end of line resistor is placed between the ‘A’ and ‘B’ terminals 
at the beginning and the end (on the last detector or output module) of each bus line. 

2.2.2 Detector Power Cables 
An appropriate cross-sectional area (csa) must be selected, suitable for 
transmission of the power to the detector loop. The following should be used as a 
guide for selecting appropriate cable: 

A Hydra CO detector requires a DC supply of 12-27 volts, at up to 40mA, with up to 30 
detectors available on a single cable. It is essential there is a minimum of 12V at each 
detector (or output module), taking into account the voltage drop due to cable resistance. 

Example: a nominal 24Vdc detector power supply has a guaranteed minimum supply of 22 
volts. The maximum voltage drop allowable is therefore 10V. Each Hydra CO detector can 
demand up to 40mA, and so for a 30 detector loop the maximum acceptable loop 
resistance is 8.33 ohms. 

A 1.5 mm2 cable will typically allow cable runs up to 300 metres. The table below shows 
maximum cable distances given typical cable parameters. 

 
C.S.A. Resistance   Maximum 
 (Ohms per km)  Distance 
mm2       Awg Cable Loop  (metres) 
1.0         17 18.1 36.2  230 
1.5         15 12.1 24.2  340 
2.5         13 7.4 14.8  560 
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Note: power cable distances can be increased by using power supplies local to detectors. 
Once the installation has been completed and the system is powered-on, check that each 
detector receives at least 12 Vdc.  

 

 
Figure 3 – Detector and Output Module Wiring 
 

Control Panel 
Serial Board 
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2.3 DETECTOR AND OUTPUT MODULE ADDRESSES 
2.3.1 Detector address 
Every detector connected to the control panel is identified through a code that enables 
communication and programming. The 4-digit code shown on the control panel display 
contains all the base specifications for physical identification. 

Example: 

DETECTORS 

Serial loop Detector Address Always 1

Chn2041

 
 

Serial Loop The number of the bus to which the identified detector is connected (ie Bus 1 
to Bus 4). In this case Bus 2 is shown. 

Detector Address Each serial loop can have up to 30 detectors. The address must be 
between 02 and 31 (addresses 0 and 1 are reserved for output modules). Each detector 
must have a unique address set using the Calibration Keypad. Refer to Hydra detector 
instruction for more detail. It is strongly recommended that the detector address is noted on 
each detector or cable-tag for future reference.  

2.3.2 Output module address 
Digital output modules also have a code which allows configuration and contains all the 
required data to physically identify it. 

Example: 

Serial loop Module 
Address 

Channel 
number on the 
module 

C h n 10 0 1

 
Serial Loop The number of the bus to which the identified module is connected (ie Bus 1 
to Bus 4). In this case Bus 1 is shown. 

Module Address  Each serial loop (bus) can have up to 2 output modules. The address 
must be 0 or 1. The first 4 inputs in the control panel have the address 0. The first 4 outputs 
of the module with address 0 on the serial bus 1 operate in tandem with the four relays 
fitted in the control panel. 

Channel Number Each module has 16 output channels numbered from 1 to 16. 
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2.4 CONTROL PANEL LAYOUT 
The location of control panel modules and connections are shown below. Detector cables 
are connected to the Serial Boards as detailed (Bus 1, Bus 2 etc). 

 
 
Figure 4 – Control Panel Module Arrangement 
 
Ensure that terminals 7, 8 and 9 are connected to terminal 5 on the CN9 terminal block on 
the field interface board. This disables signals which are not available as standard on the 
control panel. Please contact Crowcon if these functions are required; additional equipment 
will be needed. 
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3. SYSTEM FEATURES 
3.1 FRONT PANEL CONTROLS 
The Crowcon Hydra control panel is made of an aluminium front panel on the back of which 
are mounted the CPU card and the alarm signals. Eight function pushbuttons (F1..F7, 
HELP), a numerical keypad containing the keys Esc. and Ent., a keyswitch and eight visual 
indicators are to be found on the front of the control panel  

A 32 character x 8 row display is used to communicate with the operator both during 
system programming and when the control panel is in the normal operating condition. 

 
Figure 5 – Front Panel Arrangement 
 

The control panel can control a maximum of:   

120 Hydra detectors on four serial loops RS485 (max 30 for loop) 

132 outputs: four of which are relay outputs within the control panel, and 128 are remote 
open collector outputs on four serial loops RS485 (max 2 modules with 16 outputs per loop) 

The control panel can be programmed either via the front mounted keypad or using a 
personal computer and suitable configuration software (supplied on CD with the control 
panel). Some of the options, such as editing the display text can only be programmed from 
a personal computer. 

The system configuration functions are password (or keyswitch) protected, thereby offering 
the maximum operating security. 

The control panel has an event log, which memorises all the alarm, fault and operator 
operations. These can be printed out in real time using a Centronics™ printer connected to 
the control panel. 

The control panel features a ModBus interface, permitting a host system (on request) to 
interrogate the status of the control panel inputs and outputs. Contact Crowcon for 
instructions on connecting to a ModBus ‘master’ controller.  

Each input channel (detector) can be in one of the following five conditions: normal; fault; 
threshold 1 alarm; threshold 2 alarm; threshold 3 alarm. 

Operating the key-switch on the front panel has the same effect as keying in a password, 
and allows an authorized user to access the system configuration settings. 
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3.2 CONNECTING A PC 
The control panel can be connected to a Personal Computer (PC) using the RS232C serial 
port, to permit initial programming or system management with an appropriate management 
software (supplied with the system). Either of two serial ports may be used to connect a 
PC: the 9 pin male connector found on the front panel, or reverse side of the CPU card 
(CN8). The CPU card layout and interface lead wiring diagram are shown in Fig. 6 

 
 
Figure 6 – PC Connection Details 
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4. SYSTEM OPERATION 
 
Note: Crowcon Hydra systems are supplied un-configured; a new configuration file 
must be created before commissioning and operating the system (refer to Appx F). 

4.1 SYSTEM OPERATING MODES 
The control panel has three system operating modes: 

• Set 

• Unset 

• Programming 

The system can be in one of three operating conditions: 

• Normal operation 

• System alarm 

• System Fault 

The two main operations that can be carried out on the panel are: 

• Silence the sounder (buzzer) 

• Reset the system 

 

On power-up the control panel will always default to System Set and System Fault. 

The default user password is: 543210. 

4.2 SYSTEM STATUS 
4.2.1 Normal Status 
During normal operation and after start up, the control panel is in SYSTEM SET mode  (as 
shown on display). In this mode, the control panel continually checks the status of each 
detector and stores the data. The status of detectors can be checked using the function 
buttons: for example the location of any detector registering a gas alarm can be identified. 

4.2.2 Alarm status 
When one or more detectors sense gas above a threshold value, the system enters alarm 
status. Three levels of alarm can be set for each detector. 

4.2.3 Fault status 
When one or more detectors are in fault, or there is a line fault (eg the cable has been 
disconnected), the system enters fault status. In this condition the control panel works 
normally, with the exception that the faulty detectors or cable loop are isolated. 

The system remains in this state until the fault is corrected, or the affected detectors are 
UNSET from the system in programming mode (ie temporarily removed from the system 
configuration). 

4.2.4 Acknowledge 
When there is an alarm condition, the control panel sounder can be silenced by: 

turning the key to PASS or entering the correct password, wait for display ACK message, 
turn the key to ON and push the function button as shown on display (‘SIL’). 

The control panel performs a lamps test and silences the sounder. 
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4.2.5 Reset 
With the system SET, and in FAULT, the control panel sounder can be silenced (see 
above). The system remains in this state until the fault condition(s) have been eliminated, 
after which the system can be RESET (which resets the alarms and returns the control 
panel to a stable SET condition). Unlike an alarm condition, even if the fault condition 
persists it is possible to go from the SET & SILenced state to the PROGramming mode, 
from where it is possible to change the system configuration and if necessary isolate the 
faulty detector. 

Turn the key to PASS or enter a password, wait for display ACK message, turn the key ON 
and push the function button as shown on display. 

The control panel performs a lamps test of the LEDs and resets the system. 

 

4.3 DISPLAY 
A 256x64 pixel LCD graphic user display is used to keep the operator informed. The text is 
displayed on eight lines, the first of which is dedicated to displaying the time and date whilst 
the last line is used to identify the function buttons (F1  … F7). 

 

01.03.07         10:45 
 
 

* *  System  set  * * 
 
 
 

Chn  Evt  Psw  All       HELP 

 

The six lines in the middle are used to give information relating to the status of the 
channels (alarm status etc), and are an aid to programming when used together with 
the keypad. 

4.4 SYSTEM STATES 
During Normal Operation (Fig. 7) with the control panel in SET mode, keying in the correct 
password or turning the key to PASS will give the options to UNSET or RESET the system 
by pressing the appropriate function key. PROGramming mode can be entered once the 
system is UNSET. 
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Figure 7 

NORMAL OPERATION

SET UNSET PROG
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When the panel is SET, and in an alarm condition (Fig. 8), the control panel sounder can 
be silenced (see section 4.2.4), upon which the panel is in SET & SILenced state. The 
system remains in this state until all the alarm conditions (ie gas) has cleared. The operator 
can then perform a RESET (which resets the alarms and returns the control panel to a 
stable SET condition), or UNSET the system (from which PROGramming mode can be 
accessed).  

Figure  8 

 
With the system SET, and in FAULT (Fig. 9), the control panel sounder can be silenced 
(see section 4.2.4), upon which the panel is in SET & SILenced state.. The system remains 
in this state until all the fault conditions have been eliminated. The operator can then 
perform a RESET (which resets the faults and returns the control panel to a stable SET 
condition). Unlike the alarm condition, even if the fault condition persists it is possible to go 
from the SET & SILenced state to the PROGramming mode, from where it is possible to 
change the system configuration and if necessary isolate the faulty detector. 

Figure  9 

 

4.5 SYSTEM FUNCTION BUTTONS (SET MODE) 
SYSTEM SET mode is for the large part the normal operating state of the system. The 
control panel enters this state on power. 

During normal operation with the control panel in a quiescent state, the text **SYSTEM 
SET** will be displayed, together with the time and the date on the first line and the 
functions Chn, Evt, Psw and All, which are associated with the function buttons F1, F2, F3 
and F4 on the last line. 

ALARM CONDITION

END
ALARM

START
ALARM

SET ACK SET & SIL

RESET

UNSET PROG

FAULT CONDITION

END
FAULT

START
FAULT

SET ACK SET & SIL UNSET PROG

RESET
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4.5.1 Ch+ / Ch- Buttons 
Pressing the F1-Ch+ button repeatedly will show the all the first channels which are active 
in the control panel. Continuing to press the F4-Ch-  displays all detectors in succession. 

01.03.07 SYSTEM SET    10:45 
Chn1041 Engines : 7 %LE L1 L1 1 
Chn1042 Machinery : 0 %LE ok 
Chn1043 Lobby : 0 %LE esc 
Chn1044 Null : dis 
 
 
Ch+  Evt  Psw  All  Ch-  Gra  HELP 

 
Each channel has the following supplementary information: 

The address which identifies its physical location. The associated name (user set); The 
measured value; The unit of measure; The current status; The non silenced status. 

e.g.: Chn1041 Detector ID: in this example Detector 3 (address 4) on cable loop 1. 

 Engines User defined name for the detector 

7  Measured gas value (0 to full-scale of the detector) 

 %LE  Percentage of the LEL (ppm will be displayed for a CO detector) 

 L1  1st Alarm threshold 

 L1  1st Alarm threshold  not silenced 

1 Zone 

4.5.2 Evt Button 
Pressing the F2-Evt button accesses the event memory.  

 

01.03.07                                                    10:45 
 
Logged on the: 01.03.07     10.40 

* * *  SYSTEM SILENCED * * * 
Admin. 
 

 
-1    -25    +1    +25             Prt    End    Help 

 
The active functions are: 

F1 -1 view the previous event 

F2 -25 view 25 events previous 
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F3 +1 view the next event 

F4 +25 view next 25 events 

F6 Prt print out the event log (only if the printer has been enabled) 

F7 End return to viewing the channels 

Together with the event the following additional information is displayed: 

• the name of the event; 

• the address of the channel in alarm or in fault 

• the address of the detector/loop that has ceased to communicate 

• the name of the active menu 

 
4.5.3 Psw 
After pressing the F3-Psw the operator is required to enter his password, after that, 
authorized users can silence the sounders, reset or unset the system or enter into the 
programming mode. 

The above operation can also be done via the key switch, which permits entry at a higher 
level. 

4.5.4 All 
Pressing the F4-All button shows the same channel information as pressing the F1-Chn 
button, with the exception that only the channels in alarm will be displayed. The channel’s 
attributes remain unaltered. 

4.6 UNSET MODE 
 

01.03.07   10:45 
 
 

* *  System  Unset  * * 
 
 
 

Ch+  Evt  Pss  All  Ch-    HELP 

 
In this state, all the inputs are operational as normal, as are the Alarm/Fault LED’s, but both 
the buzzer and all the outputs will be deactivated (inhibted). 

The system can be changed fro SET mode to UNSET mode by entering the password 
(having pressed the Psw button) or using the keyswitch. The display will show the day, the 
date and the text: SYSTEM UNSET. 

The function buttons   F1 to F5  offer the same functions as in SET mode. 

In this mode the operator can only: 

• Look at the event log 
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• Enter into the programming mode 

• Set the system 

4.7 PROGRAMMING MODE 
Warning: the operations described in this section could be compromise the functionality of 
the system; only authorized and trained personnel should access this mode. 

 

The main menu is displayed immediately after the system enters the programming mode 
(which is logged into event memory). 

 

01.03.07    programming                     10:45 
  F1  PROGRAM INPUTS 
  F2  PROGRAM OUTPUTS 
  F3  PROGRAM SYSTEM 
  F4  PROGRAM DEFAULT 
  F5  PROGRAM USER  
  F7  END 
 

 

 
F1  INPUTS  allows the programming of the control panel input parameters 

F2  OUTPUTS  allows the programming of the control panel output parameters 

F3  SYSTEM  allows the system clock and printer mode of operation to be set 

F4  DEFAULT  allows the default setting to be restored 

F5  USER  allows new users and passwords to be programmed 

F7  END escape from the programming mode and enters into the system 
unset mode. 

 
The control panel will automatically exit from any menu and go into an UNSET state, if no 
keys are pressed for one minute. 

4.7.1 Inputs 
Pressing the F1  button whilst in the programming menu will call up the following display: 

01.03.07                                                10:45 
Chn1041   Ins   %LE   Up   is000   fs100 
 F1 SET/SPARE/UNSET 
 F2 INPUT PARAMETERS 
 F3 OUTPUT ASSOCIATION 
 F4 THRESHOLDS SET 
 F5 NEXT CH. – F6  LAST CHN. 
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 ? ZONE                                       F7 END 

 

Using the F5  and F6  function buttons one can scroll up and down the channels. 

Using the  ?  and           buttons it is possible to apply a zone number for the input 
channel. 
The second line shows the default settings or the last configuration of the input channel 
selected: 

• The physical address of the channel from Chn1041 to Chn2158. 

• Status of the channel (default Unset): 

SET channel SET condition of normal operation: will trigger the 
outputs in event of an alarm or fault. 

Dis channel UNSET detector operates normally but does not activate 
the outputs; the alarm indications on the display 
are shown as usual. 

Spr channel AVAILABLE no detector connected; when the system is set 
there will be no indication from this channel. 

• Unit of measure (default %LE): 

%LE LEL percentage of the lower explosive limit 

%O2 percentage of oxygen in the air 

%Vo percentage by volume 

ppm parts per million 

°C degrees centigrade 

°K degrees Kelvin 

Bar pressure in Bar 

MBa pressure in mBar  

• Signal direction (default UP): 

Up signal rising the alarm thresholds are activated when the there 
is an increase in the measured value 

Dn signal falling the alarm thresholds are activated when the there 
is an decrease in the measured value 

• Input scale (default depends on the unit of measure): 

Isxxx scale start value 0 per percentage unit of measure 

Fsxxx     scale end value       100 per percentage unit of measure (30% for O2) 

Pressing the F1  button enables the status of the channel to be set. The text string, Set, 
Unset, Spare, on the second line of the display will change. 

Inputs belonging to the non-inserted modules cannot be programmed and are considered 
spare. 
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Pressing the F2  button, allows the various sensor parameters to be set: 

01.03.07                                                      10:45 
Chn2041   Ins   %LE   Up   is000   fs100 
  F1  MEASURE UNIT 
  F2  SIGNAL DIRECTION 
  F3  SENSOR PARAMETER 
  F7  END 
 
 

 

Pressing the F1  button changes the unit of measure of the channel showing all those 
allowed in succession. 
If the required measured unit is not percentage, two new commands will be displayed: start 
valour (value) and end valour (value). These are the engineering values of the detector. 

01.03.07                                                       10:45 
Chn2041   Ins   ppm   Up   is000   fs100 
  F1  MEASURE UNIT 
  F2  SIGNAL DIRECTION 
  F3  SENSOR PARAMETER 
  F4  START VALOUR 
  F5  UP VALOUR 
  F7  END 

 

Pressing the F2  button the permits the signal direction to be set: rising (Up) or falling (Dn)  

Pressing the F4  button the scale start value is requested. If the unit of measure is a 
percentage then the scale start is always 0 and is not programmable. 

Pressing the DEL  button deletes the current value, key in the new value and 

confirm by pressing ENT . The maximum value must be between 0 and 999. 

Pressing the F5  button the scale end value is requested. If the unit of measure is a 
percentage then the scale end is always 100 and is not programmable. 

Pressing the DEL  button deletes the current value, key in the new value and 

confirm by pressing ENT . The maximum value must be between 0 and 999. 
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Pressing the F3  button shows the  sensor parameter menu: 

01.03.07                                                       10:45 
Chn2041   FA   bt001   is000   fs025 
  F1  OUTPUT 1 MODE 
  F2  GRAPHIC TIMING 
  F7  END 
 
 
 

 

Pressing the F1  button the permits the detector’s output 1 mode; 

(FA = Fault – S1 = Threshold 1) 

Pressing the F2  button the graphic timing value is requested. (default value: 1 second). 

Pressing the F7  button returns to the parameter input setting menu. 

Pressing F3  at this point permits the outputs to be linked to the input thresholds: 

01.03.07                                                    10:45 
Chn2041   Ins   %LE   Up   is000   fs100 
  F1  FAULT OUTPUTS 
  F2  THRESHOLD 1 OUTPUT 
  F3  THRESHOLD 2 OUTPUT 
  F4  THRESHOLD 3 OUTPUT 
  F7  END 
 

 
It is possible to link up to 4 outputs to each alarm level, including fault. 

Pressing F1  allows the outputs to be activated in the event of a fault condition: 

01.03.07                                                  10:45 
Chn1041   Ins   %LE   Up   is000   fs100 
  F1 OUTPUT 1            0000 
  F2 OUTPUT 2            0000 
  F3 OUTPUT 3            0000 
  F4 OUTPUT 4            0000 
  F7 END 
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The four digit numbers represent the physical address of the outputs to be linked, in this 
case to the fault condition of the channel selected. The numeric code 0000 indicates that 
the output is not used. 

Pressing F1  allows the code of the first fault output to be set. Up to a maximum of 4 
outputs can be set in a similar way. The same output can be used for a number of channels 
and a number of threshold values. 
The same procedure is used to set the outputs linked to the three alarm thresholds. 

Pressing F7  returns to the main input settings menu 

Pressing the F4  button allows the three alarm thresholds to be programmed using the 
same units of measure as are associated with that channel. 

01.03.07                                                  10:45 
Chn2041   Ins   %LE   Up   is000   fs100 
  F1  set threshold 1 005 
  F2  set threshold 2 015 
  F3  set threshold 3 020 
  F4  buzzer threshold 1 ON/OFF 
  F7  END 
 

 

The three digit numbers indicate that current threshold settings. 

Pressing  F1  allows the 1st threshold level be set for the channel selected. 

Pressing DEL  deletes the threshold value , the new value is input and confirmed by 

pressing ENT . 

With F2  the second threshold value is set, with F3  the value of the third. Using F4  the 
buzzer can be linked to threshold 1. Note that  the second and third thresholds are always 
linked to the buzzer. 

Pressing F7  ends the procedure for programming threshold levels. 

 

Pressing F7  ends the input programming procedure and returns to the main programming 
menu. 
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4.7.2 Outputs 
Pressing F2  from the programming menu calls up the following display and permits 
programming of the control panel outputs: 

 

01.03.07                                                    10:45 
Out1001   normal   Stb   Lo   Or 
 F1  ACTIVATION EVENT 
 F2  ACTIVATION TYPE 
 F3 ACTIVATION LEVEL 
 F4  MODE OF OPERATION (AND/OR) 
 F5  NEXT CH – F6  LAST CH 
 F7  END 

 
The second line displays the settings of the output channel selected. 

The Activation Event F1  links the output to particular events as well as the input states: it 
can have the following values: 

• physical address of the channel. 

• status of the channel (default Normal): 

Normal the output is activated only after alarm or fault conditions 
associated with various inputs. 

Set the output is activated when the system is set. 
Siren the output is deactivated when the system is silenced 
Line fault the output is activated when the G-RIO serial loops are in a fault 

condition. 

• the Type F2  of output can have three values: 

Stb Stable follows the course of the alarm; alarm activated, output 
activated after a possible activation time delay; alarm disabled, 
output low after a possible activation delay. 

Imp Pulsed produces a pulsed output with a time dependent on the alarm 
start time and after any programmed delay. 

Mem Latched as per the stable output, but becomes disabled only after the 
system has been reset. 

• The activation Level F3  (default Lo) 

Lo Low The alarm deactivates the normally active relays (fail safe). 
Hi High The alarm activates the normally off relays (normally-de-

energised). 
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The  Mode of Operation F4  (default Or) 

Or One the output is activated if one of the events linked to that output 
goes into alarm 

And All the output is activated if all of the events linked to that output 
go into alarm 

 

Pressing F1  permits the activation event to be changed and the change will appear 
immediately in the first line next to the physical address of the channel. 

Pressing F2  (activation type) permits the respective parameters to be set for the output 
modes:  

01.03.07 10:455 
Out1001   normal   Stb   Lo   Or 
  F1  REFLEX OUTPUT 
  F2  PULSE OUTPUT 
  F3  LATCH OUTPUT  
  F4  SET DELAY 0000 
  F5  UNSET DELAY 0000 
  F7  END 

 

Pressing F1  selects the “Stable” (Stb) type of output. When the linked alarm occurs the 
control panel activates the output after the activation delay. When the alarm condition 
resets the output resets after the deactivation delay. 

Pressing F2  selects the “Pulsed” (Imp) type of output. When the linked alarm occurs the 
control panel activates the output after the activation delay. The output resets after the 
activation time even if the alarm condition is still present 

Pressing F3  selects the “Latched” (Mem) type of output. When the linked alarm occurs the 
control panel activates the output after the activation delay. The output remains active until 
the control panel is reset, which can only occur once the alarm condition has reset. 

Pressing F4  sets the activation delay (in seconds) which applicable to all types of output. 

Pressing F5  sets the deactivation delay time (in seconds), if the output is a stable type or 
the pulse duration if the output is of a pulsed  type. Pressing this key has no effect if the 
output is a latched type. 

The DEL  button deletes the current value, inserting the new value and pressing ENT  
confirms the operation which will be displayed in the menu next to the selected function. 

 

The F7  button returns to the main output menu in which the F3  button allows the 
activation level of the output to be set. 
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The output can be programmed as active high (Hi), that is to say that in normal operation 
the output level is low and the relay is not energised. The associated alarm energises the 
relay. 

Conversely it can be programmed as active low (Lo), that is to say that in normal operation 
the output is level high and the relay is energised. The associated alarm de-energises the 
relay. This type of operation is called fail safe and will activate the valves connected even if 
the control panel is un-powered. 

Pressing F4  allows the output to be configured as And or Or. 

Only one alarm condition, linked to the output, will activate the output if configured as Or 

All the alarm conditions, linked to the output, need to be active to activate the output if 
configured as And. 

The F7  button returns to the main programming menu 

 

4.7.3 System 
The system parameters can be changed in this part of the programming menu: 

01.03.07 10:455 
Out1001   normal   Stb   Lo   Or 
  F1  TIME AND DATE SET 
  F2  PRINTER SET 
  F3  ZONE SET 
  F7  END 

The clock settings are available by pressing the F1  button and following the on screen 
instructions to set the hours and minutes. 

The DEL  button deletes the current value, after keying in the new value, pressing ENT  
confirms the change. The active function keys are as follows: 

F1  hour   F4  month 

F2  minutes  F5  year 

F3  day   F7  End 

Pressing F7  escapes from this menu and updates the system. 

The clock parameter changes are diregarded and the menu reverts to the main system set-
up menu if no key is pressed within approximately one minute. 

Pressing F2  changes the menu to printer settings. 

01.03.07 10:45 
DISABLED PRINTER  
   F1   DISABLED PRINTER  
   F2   PRINT EVENT LOG 
   F3   PRINT ALL 
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   F7   END 

 

Pressing F1  disables the printer. 

Pressing F2  prints out the event log. 

Pressing F3  the events are printed as they happen. 

It is best to disable event log printing if the printer is not present 

The F7  button returns to the main programming menu 

 

Using F3  it is possible configure the zone and link to a push-button (Signalling box): 

  01.03.07 10:45 
Zone     01 P00 P00 P00 P00 
  F1  PUSH-BUTTON 1 
  F2  PUSH-BUTTON 2 
  F3  PUSH-BUTTON 3 
  F4  PUSH-BUTTON 4 
  F5  NEXT ZONE  -  F6  LAST ZONE 
  F7  END 

 

The second line shows the current zone that you can change with F5  end F6 . 

Using F1  is possible to link the first Push-Button to the current zone. The system will be 
asked the physical address of the push-button to be linked. 

With F2 , F3  and F4  you can link other three push-button to the current zone. 

The F7  button returns to the last menu 

 

The F7  button returns to the main programming menu 

 
4.7.4 Default Settings 
The procedure described resets the configuration to its factory default settings 

Pressing F4  from the main programming menu displays the Reset Parameters option. 

The F1  button resets the all the settings. 

Warning: All the user configuration settings will be deleted. 
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4.7.5 Setting-up Users 
The control panel has ten users and one manager. Each user has an individual password 
and it is possible to assign to each a selection of authority levels, for example: 

• Activating the system 

• Programming the system 

• Silencing alarms 

a menu with the following options is displayed: 

01.03.07                                                    10:45 
Op.:  00   Ins   Tac   Pro 
  F1  USER PASSWORD 
  F2  USER LEVEL 
  F3  NEXT USER 
  F4  LAST USER 
  F7 END 
 
 

 
The second line of the display shows the settings relative to the user selected: 

Op.: 0 user code 

Ins setting the system allowed 

Tac silencing the system allowed 

Pro programming the system allowed. 

Pressing F1 , Password  option allows the password of the user selected to be changed. 

The F2  button Rights allows the selected user to be assigned or denied system rights. 
The other three buttons are used to pass from one user to another and to escape. 

No password is linked to the key switch, and permits entry into the system at the highest 
operator level, that is to say with all system rights. The system rights for the key switch are 
not programmable. 
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5. APPENDIX A – DETECTOR INSTRUCTIONS 
5.1 INSTALLATION NOTES 
Detectors are to be installed with consideration to the gas to be detected and in 
accordance with all national rules in force. 

Detectors must be mounted close to any possible source of gas leaks or where any 
eventual gas stagnation can be foreseen. 

To measure explosive gas with a specific weight heavier than air (eg petrol vapour or LPG), 
the detectors must be installed approximately 30-50cm. from floor. To measure toxic gas 
(eg CO or NO2, we recommend to mount the detector at “nose height” approximately 150-
160 cm. from floor. 

Consideration should be given to the security of detectors installed in public areas such as 
car parks. It is advisable that a coarse-mesh cover be fitted over the whole of the detector 
to prevent deliberate damage by vandals. It is imperative that any cover fitted does not 
prevent gas from reaching the sensor. 

As a guide, one detector can cover approximately 80-100 m2 when considering a square 
area without obstacles. Application specific standards must be referred to when deciding on 
the quantity and coverage of detectors. 

Ventilation patterns must be considered when locating gas detectors. Consideration must 
be given to the likely movement of a gas cloud due to draughts (doors, windows, 
ventilation, etc.). Avoid installing gas detectors close to air intakes or fans causing strong 
air currents. 

Ensure detectors are attached to a firm base to prevent damage or spurious functionality 
due to vibration. 

Although the electronics comply with EC electromagnetic compatibility rules, it is advised to 
keep the detectors at a distance from any radio frequency transmitters (such as radio links 
or similar). 

The detector must always be mounted with the sensing element facing downwards. The 
detector enclosure must not be drilled; wall-mount the detectors using the mounting lugs 
provided. Detectors must be protected from direct contact, or immersion in water. 

Detectors must be accessible for maintenance and calibration after installation. 
Maintenance must be regularly performed in compliance with these instructions. 

There are some substances that, when present in the atmosphere being analysed, can 
considerably change the response of the sensor and even cause irrevocable damage. In 
particular silicones, silicon halides, tetraethyl lead, hydrogen sulphide, carbon tetrachloride, 
trichloroethylene. In applications where these compounds may be present it is 
recommended to check the detector's sensitivity (using test gas) at regular intervals, and 
always after an alarm occurrence. 
 
Detectors are factory calibrated. Future calibration must be carried out by the ST.CKD 
calibration keypad (see Appendix C). 
 
5.2 INTRODUCTION 
The Crowcon Hydra gas detector has been designed for operation in commercial 
applications: non-classified areas. The detector is dust and water protected to IP55. 
Hydra has been designed to detect gas concentrations in an atmosphere mainly composed 
of air. Versions are available to detect explosive vapours (%LEL), Carbon Monoxide (CO) 
or Nitrogen Dioxide (NO2), with a concentration expressed in ppm (parts per million). 
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The type of catalytic sensor employed in flammable detectors, and the electrochemical cell 
employed in CO and NO2 detectors both offer superior precision and selectivity, thus 
avoiding false alarms and assuring an excellent reliability over time. 
 

5.3 CALIBRATION AND MAINTENANCE 
Once power has been applied to detectors, allow a minimum of 2 minutes for sensors to 
stabilise. Communications between the control panel and detectors is established 
automatically once detectors addresses have been set. 
 
It is essential that detectors are routinely tested using calibration gas. Crowcon 
recommends detectors are tested every 6 months as a minimum, and calibrated as 
necessary. 
 
Detectors should also be tested after any spurious gas alarms or faults to ensure correct 
operation. 
 
Detectors must be zeroed in clean air prior to calibration. 
 
Where a sensor fails to respond to gas, and cannot be calibrated using the instructions in 
Appendix C it must be replaced. Contact Crowcon for part number information. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Accessories required for calibration: 

• Calibration Adaptor (part number: C02125) 
• Calibration Keypad (part number: C02124) 
• Calibration gas (contact Crowcon for part numbers) 
• Calibration gas regulator (contact Crowcon for part numbers) 

 
See Appendix D for calibration instructions. 
 

RS485 Switch 
Position 1 connects to the RS-485 bus 
Position 2 connects to the Calibration 
Keypad 

Green LED: active when switch is in position 2 
(detector is disconnected from bus) 

Green LED confirms RS485 bus activity (detector 
is connected to bus)

Calibration Keypad connection port 
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If fitted, the back-up battery in the control panel and/or detector loop power supply should 
be checked regularly. Lead-acid type batteries should be replaced every 2-3 years on 
average. 
 
All functions of the control panel, detectors, output modules, alarm devices and control 
system interfaces must be checked and verified at the commissioning stage, and regularly 
afterwards during the operating life of the system 
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6. APPENDIX B – OUTPUT MODULE INSTRUCTIONS 
The optional output module ST.G/OUT16 must be secured using the four 3mm holes 
located at the corners of the PCB. The module can either be installed inside the wall-
mounted control panel enclosure, or anywhere on a detector bus within a suitable weather 
protected enclosure. 

One or two output modules can be connected in serial mode (RS485) on any detector loop. 
Each output module must have a unique address on the communications bus. If the 
module is the last element on a loop, a 120Ω terminating resistor must be fitted across the 
RS-485 wires. 

Power to the output module must be supplied separately (eg from the detector power 
supply cable loop). It is recommended that power  required to drive audible/visual alarms 
etc is supplied from a separate source. 

 
Each serial loop (detector loop) can accept up to 2 output cards with the following 
addresses: 

 

Jumper 

address 
0 1 2 3 

0 0 0 0 0 

1 0 0 0 1 
 
Set the address using links JP3 as shown. 
 
All 16 outputs are open-collector type rated at 50mA maximum. The outputs are designed 
for driving relay coils, which in turn are used for signalling or activating alarm devices. 
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Output module connection details 
 
 

 
 

 

 

 

 



Addressable Gas Detection System Manual     
 

 
Addressable System  Manual 34 
Issue 3, November 2009 

7. APPENDIX C – CALIBRATION KEYPAD INSTRUCTIONS 

 
 
The calibration keypad enables the detector address to be set, zero and calibration to be 
performed, and faults to be reset. 
 
7.1 CONNECTING THE KEYPAD 
The keypad should be connected to the appropriate port inside the Hydra detector (see 
Appendix A) using the ribbon cable which is stored in the keypad battery compartment. The 
keypad may be connected when the detector is switched on. The RS485 switch inside the 
detector must be set to Position 1 (see Appendix A) before connecting the keypad. 
 
Once connected, the keypad will display the gas concentration being measured by the 
detector (which should be 0 in clean air). 

7.2 ADJUSTING SETTINGS 
 

The diagram on the following page shows the calibration keypad menu sequence. 
Note: the RS-485 witch within the detector must be set to position 2 before connecting the 
keypad if the detector address needs to be set (see section 5.3). 
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Calibration Keypad Menu Sequence 
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7.2.1 Instructions for Setting Detector Address: 
 
1. Switch the RS-485 switch to the left-hand position (the top green LED lights) 
2. Plug the keypad in: the keypad display shows '0' 
3. Hold the Enter button for 3 seconds, the display shows: 2.05d SET then '0000' 
4. Push and hold Next until the display shows '0261' 
5. Push and hold Enter for 3 seconds, display shows CAL 
6. Press Enter, the display shows Zero 
7. Press Next, the display shows SPAn 
8. Press Next, the display shows C4.20 
9. Press Next, the display shows Adr 
10. Press Enter, the display shows the current address (e.g. 0003), use Next (up) and Exit (down) to 
set the required address 
11. Press the Enter button for 3 secs, the display shows CAL 
12. Press Exit button, the display shows 'SAV' 
13. Press Enter, the display shows NO 
14. Press Next, the display shows YES 
15. Press Enter for 3 seconds, the display blanks and then shows ‘0’ 
16. Switch the RS-485 switch to the right-hand position and remove the keypad 
17. The detector is now operational 
 
7.2.2 Detector Calibration 
 
Note: During routine calibration always put the control panel into UNSET mode to avoid causing 
alarms. 
 
These instructions describe the method required to zero and calibrate a Hydra gas 
detector. 
Calibration is required whenever either Fault or unjustified Alarms due to environmental 
conditions occur (Zero adjustment) or where detectors are due for routine calibration. 
Calibration requires a calibration gas cylinder, either filled with the same gas the detector 
has been calibrated for, or a reference gas advised by the manufacturer (e.g. Propane for 
an LPG detector, or Pentane for a Petrol Vapour detector). 
A calibration cap is necessary to let the gas flow to the sensor head. 
 
Essential requirements to perform correct Zero and Span adjustments are as follows: 
 

• Gas detectors are to be in fresh air (without any gas or interfering compounds) and 
powered on for a minimum of 8 hours where practical. 

 
• Once the calibration routine is complete, a test with gas (ie ‘bump test’) must be made to 

verify the detector and control panel are operating correctly. 
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8. APPENDIX D - COMMISSIONING NOTES 
 
Note: Crowcon Hydra systems are supplied un-configured; a new configuration file 
must be created before commissioning and operating the system (refer to Appendix F 
for instructions). 
 
 
Once the system has been installed, power can be applied to the control panel and 
detector loops. 
 

1. Visit each detector in turn; verify a minimum of 12V is present. 
2. Check that 120Ω terminating resistors are fitted across the RS485 A and B 

terminals at the beginning and end of each detector loop. 
3. Connect the Calibration Keypad to each detector in turn and set a unique address 

(see Appendix C). 
4. Check that all output module addresses are correctly set (see Appendix B) 
5. Once all detector and output module addresses are set, reset the control panel and 

ensure no faults are present. 
6. Calibrate each detector in turn (see Appendix C) 
7. With the control panel in normal operating state (and correctly configured for the 

application), apply test gas to each detector and verify that the gas reading is 
displayed on the control panel, gas alarms are activated, relays are activated, any 
external control system connected registers the gas alarms. 
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9. APPENDIX E – CONFIGURATOR SOFTWARE INSTRUCTIONS 
 
9.1 INTRODUCTION 
The configurator software has been designed to make the control panel programming 
simpler and faster. Although the control panel can be fully programmed using the keypad, 
system configuration can be completed simply and quickly using the software interface.  
 
MINIMUM PC HARDWARE REQUIREMENTS 
Microprocessor: 486 SX 
RAM Memory:  4MB 
Clock frequency: 33Mhz 
 
The software has been designed to operate on Windows 98/ME/2000/XP platforms. 
 
To install the software insert the CD into the PC drive and follow the set-up instructions. 
 
Refer to section 3.2 of this manual for details on connecting a PC to the control panel. 
 
9.2 USING THE  PROGRAM 
 
9.2.1 Starting the Program 
From the Programs menu select the “ Configurator for GALILEO MULTISCAN IDI” group 
and then select “ Configurator for GALILEO MULTISCAN IDI”.  
The following window will appear: 
 

Fig. 9.1 
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9.2.2 Using the Software 
Click on the OK button, shown in Figure 9.1. This will take you into the main page of the 
software. 
 
The graphical user interface: 
 

 

Fig. 9.2 
The programming software window offers the following menus: 
• File 

• Event Log 

• Help 

At this stage no system configuration file has been set or uploaded from the control panel. 
The following section describes the procedure for creating a new configuration file, and 
must be followed when installing any new Crowcon Hydra system. 

 

9.2.3 Creating New Configuration Files 
Select New from the File menu, at which point the Modify menu, situated between the File 
and the Event Log menus, becomes active. That the Modify menu is active indicates that 
the system is ready to program the operating parameters of the control panel. 
It is advisable to nominate the working directory before starting to program the control 
panel; Select: Save As … from the File menu and proceed to name and assign a location 
for the file in question.   
 
9.2.4 Input Parameter Set-up 
Setting the input parameters, defines the input alarm thresholds, the input descriptions, the 
outputs that will be activated when an input signal exceeds alarm thresholds, etc.  
Select Inputs from the Modify menu. The following window will be displayed: 



Addressable Gas Detection System Manual     
 

 
Addressable System  Manual 42 
Issue 3, November 2009 

 
 
All the parameters relative to channel (detector) 1021 to be programmed are shown above: 
Detector 1, (address 02), connected to the first loop of the control panel. For the input 
channel coding please refer to section 2.3.1 of this manual. 
 
“Input” refers to the physical address of the detector. A downward pointing arrow can be 
found on the right hand side of the Input window, this activates a drop-down menu offering 
the available channels. 
 
“Description” From this window it is possible to assign the input in question a description: 
For example:- “CO Level 1”. 
Once the system configuration is downloaded to the control panel, this descriptor will be 
displayed together with all the other control parameters. 
 
“Status” indicates the operational status that one wishes to give the channel in question: 
 
ENCLOSED The input channel is monitored and in the event of an alarm condition all 

the associated out-puts are activated (‘Set’ on the control panel menu). 
OMITTED The input channel is monitored, but in the event of an alarm condition 

the associated out-puts are not activated (‘Dis’ on the control panel 
menu). 

SPARE The input channel is not monitored and as such no information relating 
to that channel will be displayed (‘Spr’ on the control panel menu). 

 
Only channels (detectors) that are connected to the Control Unit should be 
configured as ENCLOSED (or OMITTED if appropriate); all un-used detector addresses 
should be set as SPARE. If channel (detector) addresses are programmed as ENCLOSED 
but no detector is fitted the control panel will show a fault for that address.  



Addressable Gas Detection System Manual     
 

 
Addressable System  Manual 43 
Issue 3, November 2009 

“Measure unit” It is necessary to define the units of measurement for each detector: the 
range start-value and end-value, plus the measuring units: PPM, %LEL, °C, mB, etc.  
For Example: A gas detector which measures a range from 0 to 300 ppm: select ppm as 
the units of measure, Start Value=0, End Value=300, Measure Value=ppm. Note: the end 
of value for L.E.L.  is automatically set at 100. 

“Signal direction” This parameter sets the signal direction for the detector (normally “To 
Rise”). 
For example; the output signal CO detector in the absence of gas will be “0”. This output 
will increase proportionally in the presence of CO gas, hence  “To rise”. For Oxygen 
Deficiency detectors set to “To descent”. 

“Buzzer Threshold 1” the internal buzzer on the control panel can be set so that it does 
not activate on a Level 1 alarm from any detector. It always activates on a Level 2 or 3 
alarm. 
 
“Hysteresis” This value defines variations in the signal which will be ignored when in close 
proximity to the alarm threshold. The value is expressed as a %. When 300 ppm of range is 
set, configure a Hysteresis level of at least ‘3’. 

“Threshold 1” “Threshold 2”, “Threshold 3” defines the alarm thresholds for the 
associated outputs. When a 100 % measuring unit is configured, the alarm thresholds are 
expressed as a % of the end of scale. When 300 ppm of the range is set, the alarm 
thresholds are expressed in ppm (so, for instance, set the levels at 30, 200 and 300). 
 
“Fault”, “Threshold 1” “Threshold 2”, “Threshold 3” buttons  activate the relative drop 
down menus in which it is possible to select 4 different outputs for each of the 4 input 
channel conditions. 
Addresses 1001 to 1004 link the output to the relays fitted within the control panel. Outputs 
1 to 4 on the first output module (if fitted) will also be activated by these addresses. 
Refer to section 2.3.2 for details on output modules addresses. 
 
“Copy” This command allows the settings for a particular channel (detector) to be copied to 
other channels. 
Once all the input and output parameters for a detector have been programmed select 
“Copy” and the following window will appear: 
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Highlight the channels that are to be copied, click on “Add” and then confirm by clicking on 
“Copy”. Note: the channel descriptor is also copied when using the “Copy” command, this 
may need to be altered for each channel. 
 
9.2.5 Output Parameter Set-up 
Programming the output parameters defines how the outputs (that have been programmed 
in the various input channels), will operate. Selecting the “Outputs” option from the Modify 
menu will display the window shown: 
 

 
 
Activation event links the output to particular events or input states. It can have the 
following functions: 
 
• When NORMAL is set, this is the physical  address of the input channel (detector) 

from Chn 1021 to Chn 4311. 

• Other functions 

Low battery The battery voltage is low (if the input is used) 
AC fail There is the AC fail of the lower supply 
Battery Fault There is the battery disconnected or in fault (if the input is used) 
Line fault the output is activated when the serial loops are in a fault 

condition. 
Set the output is activated when the system is set. 
Bell the output it is activated in case of alarm and fault event. Is 

deactivated when the system is silenced 
 

The Output function can have three different modes: 

Reflex Non-latching the output follows the activity of the triggering event. For 
example an output configured as normal will activate on an 
alarm condition and reset automatically when the alarm is 
cleared. An output configured as set will activate when the 
control panel is switched between Set and Unset modes. 

Pulse Pulsed the output remains active for the programmed pulse and delay 
time (single pulse only) 

Latch Latched the output remains active until a reset procedure is performed 
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Activation (default Lo) 

Low Low Outputs are set as normally energised (fail safe). 
 
High High Outputs are set as normally de-energised. 

 

Mode (default Or) 

Or One the output is activated if one of the events linked to that output 
goes into alarm 

 
And All the output is activated if all of the events linked to that output 

go into alarm 

Set Delay  On-delay: delays the activation for the output from 1 to 999 
seconds after the triggering event. 

 
Unset delay  Off-delay: sets the duration time of an output (pulse function) 
 
 
9.2.6 System Set-up 
Select “System” from the Modify menu (see below); it is possible to decide whether the 
control panel time is synchronised with that of the PC when the data is downloaded from 
the PC to the control panel. Storing to FLASH is not implemented and hence is not used. It 
is possible to set the operation of the control panel printer from this menu. 

 
 
9.2.7 System Operators 
Up to ten different users and one manager can be programmed in the control panel.  A 
user is defined as someone that uses the control panel, for example silencing the panel 
after an alarm. 
The window shown on the following page will be displayed after selecting “Users” from the 
Modify menu. 
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To change the password of each user key in the new password in the appropriate 
“password” window; to select the user number, select the pull down menu. The entitlements 
enabled are those that have the check boxes checked in the “Entitlements” window.  

 

9.2.8 Language 
From this menu it is possible to edit all the text strings that are displayed by the control 
panel. It is advisable that only persons having a thorough knowledge of the system use this 
option as changing the text will remove all links with the relative text in the technical 
manual.  
It is advised that only the input descriptors are changed as described in the preceding 
chapter. 
 
9.2.9 Print Out 
Once the Input and Output parameter programming has finished the contents of the 
selected file can be printed. 
 
9.3 CONTROL PANEL CONNECTION FOR UPLOAD AND DOWNLOAD 
 
Note: The Crowcon Hydra control panel must be in Programming mode before 
configuration files can up-loaded or down-loaded. 
 
 
9.3.1 Configuration File Down-load 
 
Once the programming of the control panel parameters has been completed, the file must 
be down-loaded to the control panel. It is advisable to save the programming file before 
downloading the data to the Crowcon Hydra control panel using the Save option from the 
File menu. Check, using Communication option in the File menu, that the serial port 
configurations, for the port to which the control panel has been connected are correct. A 
USB to Serial converter may be used where no Serial port is fitted to the PC. 
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Once sure that all the parameters have been programmed correctly, save the file and then: 
a. Select “”Download data” from the Modify menu, key-in the manager password (default 

543210) but do not give the OK command at this point. 

b. Put the control panel into the programming mode (please refer to the control panel 
technical manual) 

c. From the “Configurator software” program give the OK command. The downloading bar 
will be immediately displayed. On the control panel display will show the message 
“Remote programming requested” during which it is not possible to carry out any other 
operation on the control panel and the control panel does not monitor the inputs. 

d. Once the data download has ended disconnect the cable connecting the control panel 
to the PC and follow the commissioning instructions shown in Appendix D. The control 
panel will go immediately into the set condition when the download is finished and as 
such any alarm or fault condition present will activate the programmed outputs. 

 

9.3.2 Uploading the Configuration File from the Control Panel 
 
When the control panel has already been programmed and it is necessary to edit some of 
the parameters, the data can be uploaded from the control panel.  
 
Put the control panel into programming mode 
Activate the Read Configuration data option in the Modify menu 
Key-in the manager’s password memorised in the control panel (default password: 
543210). 
Change all the parameters 
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Save the file and download the new set-up to the control panel 
 
9.3.3 Reading the Event Log 
Put the control panel into programming mode 
Activate the “Read” option in the “Event Log” menu 
Key-in the manager’s password memorised in the control panel (default password: 
543210).  
Wait for the date upload and if necessary save the memory log file on a diskette or to the 
hard disk (to be used as a data archive file). 
 
9.3.4 Loading an Event Log File 
The Load option of the Memory log menu allows an archived file to be opened and printed 
out, using the Print option of the File menu.  
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10. APPENDIX F – WARRANTY 
 
This equipment leaves our works fully tested and calibrated. If within a period of one year, 
the equipment is proved to be defective by reason of faulty workmanship or material, we 
undertake at our discretion either to repair or replace it free of charge, subject to the 
conditions below. 
 
Warranty Procedure 
 
To facilitate efficient processing of any claim, contact our customer support team on 01235 
557711 with the following information: 
 Your contact name, phone number, fax number and email address. 
 Description and quantity of goods being returned, including any accessories.  
 Instrument serial number(s). 
 Reason for return. 
 
Obtain a Returns form for identification and traceability purpose. This form may be 
downloaded from our website ‘crowconsupport.com’, along with a returns label, 
alternatively we can ‘email’ you a copy. 
Instruments will not be accepted for warranty without a Crowcon Returns Number (“CRN”). 
It is essential that the address label is securely attached to the outer packaging of the 
returned goods. 
Units returned to Crowcon as faulty, and are subsequently found to be ‘fault free’ or 
requiring service, may be subject to a handling and carriage charge. 
 
 
Warranty Disclaimer 
The guarantee will be rendered invalid if the instrument is found to have been altered, 
modified, dismantled, or tampered with. The warranty does not cover misuse or abuse of 
the unit. 
Any warranty on batteries may be rendered invalid if an unreasonable charging regime is 
proven.  
Sensor types have individually defined warranty periods which can differ from the hardware 
warranty period. Crowcon reserve the right to amend warranty periods for particular 
applications.  Sensor warranty is rendered invalid if the sensors have been exposed to 
excessive concentrations of gas, extended periods of exposure to gas or have been 
exposed to ‘poisons’ that can damage the sensor, such as those emitted by aerosol sprays 
Crowcon accept no liability for consequential or indirect loss or damage howsoever arising 
(including any loss or damage arising out of the use of the instrument) and all liability in 
respect of any third party is expressly excluded. 
The warranty and guarantee does not cover the accuracy of the calibration of the unit or 
the cosmetic finish of the product. The unit must be maintained in accordance with the 
Operating and Maintenance Instructions. 
Our liability in respect of defective equipment shall be limited to the obligations set out in 
the guarantee and any  extended warranty, condition or statement, express or implied 
statutory or otherwise as to the merchantable quality of our equipment or its fitness for any 
particular purpose is excluded except as prohibited by statute. This guarantee shall not 
affect a customer’s statutory rights. 
 
For warranty and technical support enquiries please contact:: 
Customer Support 
Tel +44 (0) 1235 557711 
Fax +44 (0) 1235 557722 
Email ‘customersupport@crowcon.com’ 


